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 1 INTRODUCTION
1  INTRODUCTION
The Planmeca PlanScan Lab application is intended for 
the creation and editing of a range of images obtained 
with the Planmeca PlanScan Lab scanners. The 
application has been designed to allow the following 
operations:

1. 3D optical scanning: the generation of the range images 
of the object's portion that is framed by the scanner;

2. Alignment of the range images: the group of functions that 
allows to integrate the scanning of different objects, or 
portions of objects, in order to place them accurately 
compared to each other;

3. Cleaning the range images: tools that allow to delete the 
undesired scattered points that can be present in the 
range images;

4. Generation of triangle mesh: the group of procedures and 
algorithms that can transform the range images into a 
triangle mesh;

5. Editing the meshes: tools for the elaboration of the mesh 
of triangles; for example smoothing, deleting peaks etc.
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2 INTERFACE  
2  INTERFACE
The application consists of a menu bar divided by subject 
area, a toolbar for the main operations and a toolbar on 
the far right for the refinement and processing operations 
of the acquired data.
The rest of the screen is divided into two panels for 
management and display of the data.

• The 3D View is intended for observing and orienting the 
range images and the mesh of triangles in 3D selected in 
the beside box

• The Project box management panel of the current 
scanning project contains all of the acquired and modified 
data; each time an entry is selected, it will be displayed in 
the adjacent 3D View panel. Thanks to this box, it is 
possible to carry out the project management main 
operations, among which loading and saving the range 
images and the meshes.
Using the F11 key, the software will take up 100% of the 
screen, also covering the operating system bar.
The project panel may appear empty if the system has 
been started without using Planmeca PlanManager or it 
will appear organized as in the picture if the clinical 
features of the project have been defined in PlanManager.
The coloured squares displayed are used to intuitively 
show the condition of each project element. If an element 
has not been acquired yet, the square is gray; light blue 
means that the element is still in the form of a point cloud, 
while green means that it has already been converted to a 
mesh.

NOTE
In case of guided procedure, the software automatically 
converts the shapes acquired into triangle meshes, in 
order to prepare all the necessary data for modelling.

For this reason, only the elements strictly necessary to 
move to the CAD software are transformed into mesh.
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 2 INTERFACE
2.1  3D view and interactions
The user can interact with the orientation of the image 
through either the use of the mouse or more specific tools 
that can be selected in the “View” entry of the Menu bar.
Moreover, to improve the view the user is provided a few 
mouse/keyboard combinations:

• free rotation: mouse wheel
• free shift; Alt key + right mouse button
• rotation restricted to the Y axis; Ctrl key + mouse wheel
• rotation restricted to the X axis; Alt key + mouse wheel
• rotation restricted to the Z axis; Shift key + mouse wheel
• rotation : scales the area of the currently framed data;
• accesses the menu relative to the type of selected data;
• changes the position of the light source in the image;
• if a selection tool is activated, it allows to select part of the 

data, it can also be used with some entries of the toolbar;
• if a selection tool is activated, it allows to deselect parts of 

previously selected data.
• Number from 1 to 7 rotates the 3D view to a default 

position
Some of the above described interactions can also be 
activated through some toolbar entries. The application 
automatically assigns a rotational centre in the barycenter 
of the selected object. Activating the Center rotation by 
view button, the center of rotation will be placed in the 
bary centre of the currently displayed data.
In the top left corner, it is possible to activate (View Menu 
> View data window) a box that supplies information 
about the current view, such as the number of points of 
the displayed object, the number of selected points and 
the dimension of the containment polygon of the data 
itself. Were this box difficult to read due to overlapping 
with the displayed data, the user could double click with 
the mouse on it's surface to invert its colours, thus 
improving the display.
In case of implant projects, it is possible to view or hide 
the aligned markers and the implant connections once 
they have been introduced into the project, which means 
they have to be identified and aligned first. The tools 
specific to this actions can be found in the view menu or in 
the purple toolbar.
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3 SIMPLE TOOLBAR  
3  SIMPLE TOOLBAR
The simple interface contains a single toolbar to manage 
the use of the optical scanner allowing access to all the 
basic features. In particular in the structured project, by 
selecting an element of the project this bar will adapt 
showing any additional options relative to that particular 
type of selected object.
Some functions are always present and they are, from the 
left to the right:

• acquisition
• alignment between mesh or acquisitions
• conversion of the acquisition to mesh
• export to PlanCAD Premium
• project menu (last element on the right)

Features specific to types of selected elements will be 
displayed when selected, between the export to CAD icon 
and the project menu. For instance this image displays 
the possibility to integrate the acquisition that has been 
selected in the project tree.

Acquisition
In the structured project, the scanning strategy is 
established by default depending on the object selected in 
the project tree on the left. On the other hand, in case of a 
free project, the dialogue will appear on the top right 
corner of the screen. The user has to select the best 
strategy to scan the selected object and, if necessary, 
also defining the colour of the object.

Alignment
Start alignment as described in section 5.1 "Alignment" on 
page 10. In the structured project, the function is active 
even by selecting an individual element, while in a free 
project at least 2 elements must be selected.
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 3 SIMPLE TOOLBAR
Mesh generation
Converts the selected data into a triangular mesh. In the 
structured project, the software will automatically apply 
the best strategy, while in a free project a dialogue will be 
displayed for the selection of the desired strategy.

Integration
Allows to integrate the selected acquisition with others.

In the Single mode it is possible to integrate the 
acquisition with a single view. The object inside the 
scanner moves according to the position of the 3D 
navigator. The user can check the actual position through 
the live view.
If the model has been moved from its original position or if 
the alignment is not correct it is possible to recalculate the 
position of the object by clicking the button Calc 
Integration position.

CAD software export
When working with a project defined in PlanManager, 
exporting is very user friendly: by clicking on this button, 
the PlanCAD Premium will be automatically launched; all 
of the elements will already be loaded and ready for 
modelling.
If starting with a free project, export can be managed as 
described in Chapter 6.

Project management
This command opens a context menu that provides all the 
features available to interact with the structure of the 
project. In addition to the standard functions (save, close, 
create etc.) a very useful option is provided allowing to 
modify the existing project by directly accessing the initial 
order sheet.

NOTE
Modifying the structure of a project also makes the guided 
acquisition sequence inconsistent: the wizard must 
therefore be rebooted every time such an operation is 
performed.
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4 STARTING SCAN PROJECT FROM PLANMECA PLANMANAGER  
4  STARTING SCAN PROJECT FROM PLANMECA 
PLANMANAGER

When the Planmeca PlanScan Lab software is launched 
from Planmeca PlanManager the following screen 
appears.

In the middle part of the dialogue there is a diagnostic 
message; if the scanner is correctly configured this will be 
green, otherwise if any error would occur it will be red with 
a description of the errors found. Most of these messages 
are self-explanatory and allow the users to solve the 
malfunction by themselves.
The user can decide whether to start the project 
previously defined in Planmeca PlanManager or to shut-
down the software. If the user decides to start the project 
it is possible, where needed, to modify some advanced 
parameters:

• Unsectioned Model: if the model to be scanned is 
unsectioned;
Once the project is loaded, the user can start to scan 
models aided by a Wizard 
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 4 STARTING SCAN PROJECT FROM PLANMECA PLANMANAGER
4.1  Direct launch
When the Planmeca PlanScan Lab program is launched 
directly an initial screen with the following options are 
given in the part immediately below, which the user can 
select to continue his job, respectively:

• New free project. The software will operate freely and the 
user can select the types of acquisitions to perform and 
when to perform them. The project will appear completely 
empty and will be populated by the elements as they are 
scanned; there will be no relationship between the 
elements and they will all be on the same level. As initial 
setting, the software will propose a particular folder, but 
this can be changed by the user at will.

• Creation of a guided project. In this case, based on the 
license of the software, it will be possible to define the 
type of project that is to be performed. In this case, once 
the type of job has been selected and defined, a 
structured project, compliant with the filled form, will be 
created within the software (see Glossary).

• Load existing project. The software will show a navigation 
window through which the user can select a project 
previously created and saved by the software on the PC.

• Close software. Closes the instance without creating any 
data on the PC.
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4 STARTING SCAN PROJECT FROM PLANMECA PLANMANAGER  
4.1.1  Setting up structured project
The scanning software can also be lauched directly from 
Planmeca PlanManager. In this case, by defining the 
clinical situation in the odontogram of the Planmeca 
PlanManager, the software can read the type of clinical 
situation and prepare the consequent scanning strategy.

4.2  Working with a defined project
Once the project has been defined, the software will start 
a different guided procedure case by case and will guide 
the user in the acquisitions necessary to complete the job.
It will be possible to modify some project features at any 
time in order to recover any initial errors or oversights; to 
do this, just enter the File menu and select the modify 
dental project header characterized by the icon in the 
Image.
The start odontogram will be shown, which can be 
updated as required.

NOTE
Modifying a project once the job has started could take the 
software into a conflictual state: for example, eliminating 
an element that has already been acquired and that now 
no longer has a place in the job to be performed. For this 
reason we recommend the user checks that he has filled-
in the job sheet correctly before starting the job.
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 4 STARTING SCAN PROJECT FROM PLANMECA PLANMANAGER
If you do not wish to follow the guided procedure it can be 
closed at any time and you can make use of all of the 
features linked to a structured project. Whenever the 
software with simple interface is used, the simple bar at 
the bottom right will adapt to the selection in current 
project. For example, if a stump is selected and the scan 
is launched from the simple bar, the software will 
automatically follow the acquisition strategy defined for 
that type of element.
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5 FREE PROJECT  
5  FREE PROJECT
When starting a free project the tree view of the screen is 
empty.
As the project is still empty, it is only possible to start an 
acquisition and a project.

By clicking the Acquisition button the following window 
appears. 
Enter a name for the acquisition.
Select the type of acquisition from the first drop-down 
menu.
Select the colour of the plaster that may either be the 
default value or go from very light to very dark; this will 
improve the rendering of the model

5.1  Alignment
The alignment tool is activated if two or more elements of 
the same type are selected in the project tree, i.e. all 
acquisitions or all triangle meshes.
Once this tool has been selected, the pop-up will appear. 
right. As it is a non-structured project, the software 
requires specification of which element must be 
considered fixed and which mobile: only one fixed 
element can be selected.
By clicking OK, the software will perform an automatic 
alignment by looking for common points between selected 
elements. If the alignment is successful, the elements will 
be moved to correct position.
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 5 FREE PROJECT
If the automatic alignment is not successful you need to 
frame the two objects from the same point of view and 
select one common point on both objects or, select 3 
points.

NOTE
Automatic alignment makes use of the shape the two 
selected elements have in common. If the two elements do 
not have parts in common or these parts are insufficient, 
user intervention will be requested. We therefore 
recommend to check that the selected elements have a 
sufficient common surface.
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6 GUIDED PROJECT  
6  GUIDED PROJECT
A structured project can be defined both initializing from 
the options envisioned by the software and from 
Planmeca PlanManager. In both cases, the software will 
load a structured project, i.e. a tree project, in which the 
elements are already defined and present. As default 
setting, a Project wizard dialogue will also open. You can 
either follow the dialogue’s instructions or close it and 
complete the job manually.
If you decide to use th dialogue a macro-operations list is 
shown on the left. During the procedure, the current 
operation will be highlighted. Otherwise, if you decide to 
proceed freely, it is shown in the project tree on the left.

To reactivate the wizard after closing, on the File menu 
select Start > Acquisition Wizard menu. The wizard will 
start from the beginning.
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 6 GUIDED PROJECT
6.1  Without wizard
Once the wizard has been closed, the project structure 
appears on the left: this project could also be empty or 
partially completed 
Select the element to be acquired from the list to proceed 
with the acquisitions, introduce it into the scanner and 
start scanning using the first button in the Simple tool bar. 
The software will automatically apply the best strategy for 
that particular type of selected object.
The elements acquired according to this procedure 
obviously will not be aligned with each other as they may 
have been acquired randomly. However, by selecting an 
element, the alignment tool is activated in the simple bar 
and the element selected can be aligned with its “parent” 
i.e. with the element to which it belongs. For example, if 
the user wants to align the element Stump 16 to its 
reference jaw, the upper jaw here, he just has to press the 
alignment button in the simple toolbar. The software will 
automatically detect the upper jaw as reference and it will 
start the alignment procedure.
Whenever the upper object is not yet present, alignment 
will not take place. In the same way, the conversion to 
mesh format must be performed individually by selecting 
one or more elements and consequently the tool in the 
bar: the software will apply different strategies for different 
elements. The last passage is export of the job to the 
CAD, described in section 7 "DATA EXPORT" on page 
20.

NOTE
With a structured project it is not necessary to select 2 
objects for alignment: only the individual element must be 
selected which will be automatically related to the object to 
which it belongs.
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6 GUIDED PROJECT  
6.2  Using the wizard
The first screen shown by the dialogue allows to choose 
whether to continue with the guided procedure or close it.
Optionally, it is possible to continue by starting the 
generation mode of the parallel mesh. In this mode, once 
an element has been acquired and correctly aligned with 
the others, the software converts it directly to mesh data, 
leaving the operator free to continue scanning.
As for its use, this mode is absolutely clear but allows to 
spread the heavy computational process of mesh 
generation during the entire elaboration, thus saving time.
In this case however, it will not be possible to navigate 
forwards and backwards between the wizard steps as 
there may be a conflict among the data: the sequence of 
operations requested is therefore binding.
We will now examine the different elements that will be 
displayed by the wizard during the acquisition sequence. 
On the basis of the defined project, these steps can be 
proposed in a different order; we will therefore examine 
them individually and independently.

All of the steps shown by the dialogue have the same 
sequence of commands in the lower part:

• Skip: passes the current step (could lead to conflict due to 
lack of data)

• Prev: goes back to previous step
• Next: goes to next step (it is enabled once the operation 

requested at that determined step has been concluded)
• Close: closes the dialogue sequence and allows to 

continue as described in section 6.1 "Without wizard" on 
page 13.
The parallel generation of the mesh makes the job quicker 
but the sequence off the dialogue is binding.
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 6 GUIDED PROJECT
Acquisition
The user is asked to insert the defined element. 
Moreover, it is provided a small explanation on how to 
prepare the model to be scanned.
The user is requested to define the colour of the model in 
order to improve the result of the acquisition; in 90% of 
cases, an intermediate colour corresponds to the normal 
laboratory plaster, even if it is light blue or green. The dark 
element can be used when the material is clearly darker 
than normal.
Once an acquisition has been performed, the Integrate 
button is activated, it is however possible to rescan the 
model overwriting the current acquisition.

We recommend that all parts of the screen displayed are 
read carefully: they are normally self-explanatory and 
describe what to insert into the scanner in detail.
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6 GUIDED PROJECT  
Cut
This step allows to eliminate the base of the acquisition 
with an horizontal cut.
By moving the cursor in the Image, a larger or smaller 
portion of the object will be selected and it will be 
highlighted in the 3D display panel.
The tick just below the cursor allows to apply the same cut 
level to all elements of the same type during the 
successive steps. This is particularly useful if the upper 
and lower models are mounted on the same type of 
support and therefore with the same portion to be 
eliminated.

Manual cut
This panel allows to manually clean the models that are 
shown in the 3D display panel.
All of the selection tools described in section 8.1 "Project 
management" on page 21 are activated and in the first 
part it is possible to interact with the selection made by 
inverting it, deselecting all, deleting the portion selected 
or, lastly, maintaining only the selected part.
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 6 GUIDED PROJECT
Acquiring single elements
This screen shows the individual elements specified in the 
project in a variable list. These can be stumps and scan 
bodies for the detection of implant positions.

You can select among the ones available, the elements to 
insert; in the case of stumps they must be removed from 
the original model and inserted simultaneously while 
maintaining a distance between them to allow every detail 
to be acquired. In a case of only 7 elements stumps can 
be inserted simultaneously on the model holder. It is 
always possible to insert just a part, tick the relative 
elements in the list and proceed with scanning. The 
software will successively request the user to scan the 
missing elements.
As for implant scan bodies, they need to be mounted 
directly on the model selecting the ones that are to be 
scanned; if possible we suggest mounting as many as 
possible simultaneously, remembering to check the 
position so that each scan body scan is as detailed as 
possible.
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6 GUIDED PROJECT  
As for stumps, the multi-die support can be used, which 
requires the user to insert the elements into pre-
established positions. In this case, there are a total of 9 
positions available and they will be assigned 
automatically by the software.
Using the multi-die support allows to avoid manual 
identification (segmentation) of the elements.

Segmentation
Whenever the multi-die support has not been used, the 
individual elements acquired together must be identified 
because, as there is no restriction on their positioning, the 
software cannot do it automatically.
The user must therefore select the portion of interest and 
then segment it.
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 6 GUIDED PROJECT
Acquisition check
If the parallel generation of the meshes option was 
selected in the first step, this final step will not be 
displayed.
If not, the software needs the user's authorization to 
generate the meshes. By default, the software is set to 
show each individual element and therefore generate the 
consequent mesh, to enable the user to check that 
everything is conform before converting the format. If the 
project has already been checked, tick the generate all 
option and the software will generate all the elements.
Before generation of the meshes, the software will display 
all elements that will be exported, and the user will be 
able to check that all meshes are correct before exporting 
to PlanCAD Premium
Once the wizard has been completed, the project remains 
available. If there were something incorrect or there was 
the need to change a hand modelled part it is possible to 
access to the referring options by the project.
When segmenting we suggest selecting the stump as 
completely as possible. Even though it is not strictly 
necessary for the CAD design, the software will be able to 
use all the geometry to align, thus obtaining more reliable 
results.
User’s manual Planmeca PlanScan Lab 19



7 DATA EXPORT  
7  DATA EXPORT
It is always possible to access the context menu at any 
time from the project tree by clicking with the right button 
on the desired element and export it with the desired 
format to a position of the user's choosing.
The scanning data will be exported into the *.scan format, 
which allows to reconstruct all of the scanner's 
information.
The mesh type data can be exported in the following 
formats: , STL binary, STL ASCII, off binary, off ASCII, ply 
binary, ply ASCII and waveformat obj.

7.1  Automatic export
The software also provides a feature to automatically 
export the data to the CAD software by clicking the Export 
to CAD button.

In the structured project, the software already recognizes 
the parts that compose the job and can export them 
automatically while maintaining said structure. If the 
scanner has been launched directly from PlanManager 
export will be absolutely automatic: Planmeca PlanScan 
Lab will create a project compatible with the CAD 
software and will start the modelling program directly.
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 8 TOOLBARS
8  TOOLBARS

8.1  Project management
This set of tools allows to save and load entire projects, 
as well as export and import individual sets of data, to be 
used in a project different from the one in which they were 
generated.

• New Free Project: allows to create a new project;

• New Project: allows to create a new job order sheet and 
the consequent guided project;

• Open Project: allows to open an existing project;

• Save Project: saves the current project;

• Save as: saves the current project with a new name;

• Close Project: closes the current project;

• Import: loads pre-existing data into the current project;

• Export: saves the selected data outside the current 
project;

• Start acquisition wizard: starts the guided procedure (it is 
only active if a structured project has been defined)

• Exit: closes the Planmeca PlanScan Lab application.

8.2  Selection tools
Planmeca PlanScan Lab provides a set of tools to select 
part of the data surface, meshes or acquisitions. The 
available selection tools are:

• Rectangle selection: traces a rectangular selection area 
on the surface;

• Ellipse selection: traces an elliptical area on the surface;
• Polygon selection: traces a polygonal selection area, 

defining the vertexes via mouse;
• Closed freehand selection: traces a freehand selection 

area, creating a closed shape based on the path followed 
by the cursor of the mouse;

• Freehand trace selection: traces a freehand selection 
area based on the path followed by the mouse cursor;
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8 TOOLBARS  
• Segment selection: selects the area covered by a line 
segment traced by the cursor of the mouse on the 
surface. By holding the key, it will be possible to trace 
straight lines that range between them with a 
predetermined angle (that can be set through the options 
panel and set as default at 45°);

• Pass-through / non pass-through selection (for mesh 
only): the first option selects all of the surface areas that 
intersect the current selection; the second only the 
currently visible areas . If several surface layers overlap, 
the first option selects part of every layer, the second only 
the visible one.
For each of the tools above, described by holding the right 
key of the mouse, it is possible to shift the currently 
selected area. Moreover, by pressing the Esc key, the 
currently displayed selected area can be deleted.

8.3  Acquisitions management
• Generate mesh: converts the currently selected range 

images into a mesh. The generation parameters are set 
automatically by the application once the user has 
specified the type of object to convert.
In the structured project the panel in will not be shown 
because the software will automatically start the best 
strategy for the conversion to mesh for the type of 
selected data. For example, if the acquisition of a stump is 
to be converted into mesh, the level of detail will be higher 
of that dedicated to the acquisition of an antagonist. 
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 9 SCANNER RECALIBRATION
9  SCANNER RECALIBRATION
After moving or after accidentally hitting the scanner it is 
good practise to recalibrate the instrument. To carry out 
this operation it is necessary to have a calibration kit 
available, composed by a master, an xml file, describing 
the specific master, and a normal scanning model. Each 
xml file is associated to a calibration plate that can be 
identified by the number on the rear of the plate itself; the 
xml file associated to the master supplied is provided in 
C:\ProgramFiles\PlanScanLab 2.5.
Scanner recalibration is articulated into two steps: 
recalibration of the optical head and recalibration of the 
movement system.
To start the recalibration procedure, select the 
Recalibrate head command from the Tools menu. A 
dialogue window with a request to enter the master into 
the scanner and to load the associated xml file will open.
Once ready, the automatic procedure can be launched by 
pressing the Start button. After head calibration, it is 
requested to remove the calibration master from the 
scanner and to insert a scanning model. Once 
introduction has been confirmed, the scanner will start the 
calibration procedure of the moving system.
At the end of the operation, the success of the operation 
is confirmed and the scanner is ready for use.
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